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Word Processing Fundamentals
Lesson 2
Editing a Document
2.15

Editing a Document

After completing this lesson, you will be able to:

· Open a file.

· Navigate through a document.

· Scroll through text.
· Insert text in a document.

· Select text.
· Edit a document by deleting and restoring text.
· Create a folder.
· Save a file with a different name.
Before the days of computer and word-processing programs, any correspondence done by hand or on a typewriter could include crossed-out words, correction fluid, or spelling and punctuation errors. People simply couldn’t edit without starting over or having flaws in their documents. Now that most personal and business correspondence is typed on a computer using a word-processing program, there is no more need for crossed-out words or correction fluid.

With Microsoft Word, you can quickly and efficiently edit letters, documents, reports, newsletters, memos, and faxes. Word displays a red wavy line if a word is misspelled or unknown and displays a green wavy line to indicate incorrect or questionable grammar usage.

In this lesson, you will learn how to open a file that you already created. Then, because the Word window often displays only a portion of a document at a time, you’ll learn how to scroll to view different parts of a document. You’ll move the insertion point around the document by using the mouse pointer and by pressing keys on the keyboard.

After learning how to navigate through a document, you’ll begin to edit. To edit, you first need to identify the text that you want to change. Word provides shortcuts so that you can select text by the word, line, sentence, paragraph, or the entire document. After you select the desired text, you’ll learn how to delete the selection. When you’re finished editing the document, you’ll save the file.

In this lesson, you will also learn how to create a folder in which to save the file and how to save the file with a different name.

To complete the procedures in this lesson, you will need to use the practice file Brochure 02 in the Lesson02 folder in the Word Processing Practice folder that is located on your hard disk. You’ll use this file to navigate through the document, edit text, and save the file with a new name.

Opening an Existing File

After you save a Word document, you can reopen it later to review its contents or make changes. You’ll need to navigate to the folder containing the document and then open the document itself.

Word keeps track of the last four documents that you opened. Word displays the names of these files at the bottom of the File menu so that you can open them with only a couple of mouse clicks. To open a file that is not listed at the bottom of the File menu, you use the Open dialog box. Word also will list these four files at the top of the New Document task pane so they are even more readily available when you first start Word or when you choose to open a document.

In this exercise, you open an existing file.

1
If necessary, start Word.

2
On the New Document task pane, at the bottom of the Open a document section, click the More documents link.

The Open dialog box appears.

3
Click the Look in down arrow, click the icon for your local hard drive, double-click the Word Processing Practice folder, and double-click the Lesson02 folder.

The contents of the Lesson02 folder appear in the Open dialog box.
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4
Click the file Brochure 02, and click the Open button.

The file Brochure 02 appears in Word, and the Open dialog box closes.

Keep this file open for the next exercise.
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Navigating Through a Document

To change existing text in a document, or to edit, you first move the insertion point to the location where you want to make a change. The mouse pointer, the arrow keys on the keyboard (used to move the mouse pointer or insertion point up, down, left, or right), and the scroll bars are all navigation tools that help you to move through a document.

To move the insertion point by using the mouse, simply move the I-beam pointer (the pointer that looks like a capital I) to the location where you want the insertion point to appear, and click.

important

In a new, blank document, you cannot move the insertion point with the arrow keys. With the arrow keys you can move the insertion point only to places in the document that include text, tables, or graphics. You can, however, use Click And Type to move the insertion point in a blank document.

The following table lists each keyboard key or key combination that can be used to quickly move the insertion point. A key combination is a combination of keyboard keys used to perform a function, instead of using the mouse pointer to perform the same task. For example, if the key combination is Ctrl+Home, you press and hold the Ctrl button while pressing the Home button. Word moves the insertion point to the beginning of the document.

	Press
	To move the insertion point

	Left arrow key
	Left one character (one unit of space, such as a letter, number, punctuation mark, or other symbol).

	Right arrow key
	Right one character.

	Down arrow key
	Down one line.

	Up arrow key
	Up one line.

	Ctrl+Left Arrow
	Left one word.

	Ctrl+Right Arrow
	Right one word.

	Home
	To the beginning of the current line.

	End
	To the end of the current line.

	Ctrl+Home
	To the beginning of the document.

	Ctrl+End
	To the end of the document.

	Page Up
	Up one full screen.

	Page Down
	Down one full screen.

	Ctrl+Page Up
	To the beginning of the previous page.

	Ctrl+Page Down
	To the beginning of the next page.


Scrolling Through Text

Because the document window normally displays only a portion of a page at one time, you might need to move (or scroll) the view of the document to view another section of it. If your document has more than one page, you’ll need to scroll to see the other pages of the document. The vertical scroll bar, scroll arrows, and scroll box move the document up and down. The horizontal scroll bar, scroll arrows, and scroll box move the document window left and right.
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The table on the following page lists available scrolling tools and their functions.

	Do this
	Button
	To move the document view 

	Click the up scroll arrow
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	Up one line at a time

	Click the down scroll arrow
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	Down one line at a time

	Click the left scroll arrow
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	Left a few characters at a time

	Click the right scroll arrow
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	Right a few characters at a time

	Click above the scroll box on the vertical scroll bar
	
	Up one screen at a time

	Click below the scroll box on the vertical scroll bar
	
	Down one screen at a time

	Click left of the scroll box on the horizontal scroll bar
	
	Left one screen at a time

	Click right of the scroll box on the horizontal scroll bar
	
	Right one screen at a time

	Drag the vertical scroll box
	
	Continually forward or back-ward through the document

	Drag the horizontal scroll box
	
	Continually left or right through the document

	Click the Previous Page button
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	To the beginning of the previous page

	Click the Next Page button
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	To the beginning of the next page


Inserting Text in a Document

One of the first steps to being able to edit a document is learning to insert text. Word provides two modes to insert more text. For example, if the annual report for your company was typed without a current list of all the board members, the names of the board members can be inserted later. Word uses Insert mode when you start the program. In Insert mode, when you type new text, the existing text moves to the right. The alternative to Insert mode is Overtype mode. In Overtype mode, existing text is deleted and replaced by the text you type, including spaces.

Research shows that a majority of users prefer Insert mode, so Insert mode is Word’s default mode. Double-clicking the Overtype button (in the Status bar) toggles between Insert and Overtype modes. A toggle is a button that alternately turns an option on or off each time that the option is selected.

In this exercise, you insert text into a document.

1
In the last line of the first paragraph, click just before the first s in the word skills to position the insertion point.

2
Type individual, and press the Spacebar.

The new text is added at the insertion point, moving the existing text to the right.

Keep this file open for the next exercise.

Selecting Text

To edit text in a document, you must first select the desired text. One way to select text is to hold down the mouse button and then drag the insertion point over the text that you want to select. You deselect text by clicking anywhere within the document window. You can tell when text is selected because it appears highlighted (selected text usually appears white with a black background). Any changes will affect the selected text.

To select blocks of text quickly, Word uses the selection area. The selection area is the area in the left margin of the document. You can tell when the pointer is in the selection area because the I-beam changes to a right-pointing arrow.

To select blocks of text that are not adjacent in a document, you select the first block of text, hold down the Ctrl key, and then select the next block of text. You can also use the Shift key and the arrow keys to select adjacent words, lines, or paragraphs. You position the insertion point in the text that you want to select, hold down the Shift key, and then press an arrow key or click at the end of the text that you want to select.

The following table summarizes the methods for selecting blocks of text.

	To select
	Do this

	One word
	Double-click the word.

	A line
	Click the selection area to the left of the line. 

	A sentence
	Hold down the Ctrl key and click anywhere in the sentence.

	A paragraph
	Double-click the selection area to the left of any line in the paragraph, or triple-click anywhere in the paragraph.

	An entire document
	Hold down the Ctrl key and click anywhere in the selection area, or triple-click anywhere in the selection area.


tip
You can also select text by using the keyboard. Click in front of the text that you want to select and press Shift+right arrow to select text to the right of and before the mouse pointer, or Shift+down arrow to select text to the right of the mouse pointer. Notice that if you press Shift+down arrow in the middle of a line, the selected text includes part of the next line. Likewise, if you press Shift+down arrow at the beginning of a line, the entire line is selected. You can also click at the beginning of the text that you want to select, hold down Shift, and then click at the end of the text to select a block of text.

Deleting and Restoring Text 
in a Document

Now that you know how to select text, you can easily delete a selected block of text. To delete a large section of text, select the text, and press Delete or Backspace. You can save time by selecting large areas of text to be deleted, rather than deleting the text character by character.

For example, in the annual report that you prepared for your company, you typed the introduction message from your company’s president; however, the president has now decided to write it himself. You don’t have to delete the letter one character at a time; instead select the entire letter, and press Delete. Now the page is blank and ready for the President to add his own letter.

To delete a single character, position the insertion point to the left of the character and press Delete, or to the right of the character and press Backspace. To delete whole words using the keyboard, position the insertion point to the left of the word and press Ctrl+Delete, or to the right of the word and press Ctrl+Backspace.

tip

If you use either of these key combinations while the insertion point is positioned within a word, you delete the part of the word before or after the insertion point, respectively.

Another way to delete text is to use Overtype mode. Double-click OVR on the Status bar to turn on Overtype mode. When Overtype mode is turned on, you type over the existing text.

Word keeps track of the editing changes that you make in a document so that you can easily remove a change and restore the text to the way it was prior to making the edits. If you make a mistake while editing, on the Standard toolbar, you can click the Undo and Redo buttons to change and restore text.

[image: image10.png]



To undo an action, click the Undo button. If you undo an action by mistake and need to restore or redo the action, you can do so by clicking the Redo button. To undo or redo multiple actions, click the down arrow to the right of the Undo or Redo button and select the action that you want to undo or redo. All actions completed after the one that you select in the list are also undone. Although most actions can be undone, actions such as saving and printing cannot.

In this exercise, you delete and restore text to fix some of the errors in the document.

1
Click the insertion point to the left of the last s in the misspelled word professiosal in the first paragraph.

2
Press the Delete key.
The letter s is deleted, and the remaining text is shifted to the left.

3
Type n.

The red wavy line is removed.

4
In the second paragraph, position the insertion point to the right of the letter t in the word informatl.

5
Press Backspace.

The t is deleted, and the red wavy line is removed.

6
In the second paragraph, position the insertion point in front of the a in the misspelled word aech.

7
On the status bar, double-click the overtype button.

The Overtype mode is turned on.

8
Type ea.

The word is changed, and the red wavy line is removed.

9
On the status bar, double-click OVR.

The Overtype mode is turned off.

10
Double-click the word personal in the third paragraph.

The word personal is selected.

11
Type public.

The word personal is replaced with the word public, and the rest of the text moves to the right as you type.

12
Double-click the selection area to the left of the first paragraph.

The paragraph is selected.

13
Press Delete.

The paragraph is deleted.

14
On the Standard toolbar, click the Undo button (displays the ScreenTip Undo Clear).

The deleted paragraph is restored and is also selected.

15
On the Standard toolbar, click the Redo button (displays the ScreenTip Redo Clear).

The paragraph is deleted again.

16
Click the Undo button again.

The deleted paragraph is restored and is also selected.

17
Press the down arrow key.

The paragraph is deselected.

18
Click after the second occurrence of the word and in the last sentence of the first paragraph.

19
Press Ctrl+Backspace.
The word and is deleted.

20
Press Ctrl+right arrow twice to move the insertion point to the word individual.

21
Press Ctrl+Delete.

The word individual is deleted.

Keep this file open for the next exercise.

Creating a Folder

After you create a document, you might want to save the document in a folder. A folder is a storage area on your computer’s hard disk or a network drive. A network is a system of computers connected by communications links. When a computer is connected via a network, you can use one computer to access the hard disk of another computer on the network. You can create folders to store files by project, author, file type, or just about any organization scheme you can imagine.

For example, you might have a folder named Memos. In this folder, you store all the memos that you send to your boss. You might choose to have a subfolder (a folder within a folder) in your Memo folder named Sent Marketing. This is where you store memos that you send to the marketing department. You could even have another subfolder in your Memo folder called Sent Finance. This folder contains the memos that you send to the finance department. Now when you open the Memo folder, you won’t have to wade through all the memos you have sent; instead, you have sorted and saved them in subfolders, so they are quick and easy to find and retrieve.

Word makes creating folders easy directly from the Save As dialog box. With Word’s file management features, you can easily organize, locate, and create folders to store documents and save files with different names. You can also delete files and folders from within the Open and Save As dialog boxes. To delete a file or folder, select what you want to delete, and click the Delete button or press the Delete key.

tip

You can also create new folders in Windows Explorer. You don't have to create them from within Word. To create a new folder in Windows Explorer, click the Start button, point to Programs, and then click Windows Explorer. In the Folders pane on the left side of Windows Explorer, navigate to and double-click the folder in which you want to create a new folder. On the File menu, point to New, and click Folder. A new folder appears with the name New Folder selected. Type the name of the new folder, and press Enter to rename it.

In this exercise, you create a folder.

1
On the File menu, click Save As.

The Save As dialog box appears and displays the content of the Lesson02 folder, which is the last folder that you used.

2
Click the Create New Folder button.

The New Folder dialog box appears.
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3
Type My Exercises in the Name box, and click OK.

The New Folder dialog box closes, and the Save As dialog box appears and displays the My Exercises folder. The file Brochure 02 is listed in the File name box because it is the file that is currently open.

4
Click the Cancel button.

The Save As dialog box closes and the file is not saved.

Keep this file open for the next exercise.

Saving a File with a Different Name

You might find it necessary to make a copy of a file. You can keep the original on hand for safekeeping or for comparison and then make changes to a new version. For example, suppose the marketing manager at an outdoor vacation resort named Adventure Works creates a revised brochure each year. When it’s time to create a new brochure, she opens the previous version and saves it with a new name. Using the previous brochure helps create the new brochure quickly and efficiently with just a few updates. Saving the new brochure with a new name preserves previous versions to maintain a historical archive.

In this exercise, you save the current file with a different name in the My Exercises folder.

1
On the File menu, click Save As.

The Save As dialog box appears. The content of the Lesson02 folder appears.

2
Double-click the My Exercises folder.

The My Exercises folder opens.

3
Click after Brochure 02 in the File Name box.

4
Press the Spacebar, and type Edited.

5
Click the Save button.
The Save As dialog box closes, and the file is saved with the name Brochure 02 Edited. The file’s new name appears in the title bar of your document.

Keep this file open for the next exercise.

tip

You should make a backup copy of important files to protect against losses from computer crashes, viruses, accidental changes, or deletions. You can save copies of files to floppy disks or to a network disk (a disk that is physically located on another computer, but is available to users on the same network), if one is available. The best way to safeguard files is to use a tape backup system.

Lesson Wrap-Up

In this lesson, you learned how to open an existing file and navigate through a document using the scroll bars, arrow keys, and insertion point. You also learned how to edit a document by inserting, selecting, and deleting text, and how to manage files by creating a folder and saving a file with a different name.

If you are continuing to the next lesson:

1
On the Standard toolbar, click the Save button to save changes made to the Brochure 02 Edited file.

The changes are saved to the file.

2
On the File menu, click Close to close the file.

The file closes.

If you are not continuing to other lessons:

1
On the Standard toolbar, click the Save button to save changes made to the Brochure 02 Edited file.

2
In the upper-right corner of the Word window, click the Close button.
The file closes, and the Word program closes.

Quick Quiz

1
How do you delete a document in Word?

2
What are three ways that you can scroll forward through a document?

3
If you make a mistake when editing a document, what can you do to fix the problem?

4
What keys do you press to select text to the right of the insertion point?

5
What is the Select Browse Object button used for?

6
What are three ways to open a recently opened document? 

7
What menu command do you use to open an existing file? What toolbar button? What task pane option?

8
What is the difference between scrolling and moving the insertion point?

9
How can you select a sentence within a paragraph?

important

In the Putting It All Together section that follows, you must complete Exercise 1 to continue to Exercise 2 and Exercise 3.

Putting It All Together

Exercise 1: If necessary, start Word. Open the file SkillCheck Lesson 02, in the Lesson02 folder in the Word Processing Practice folder that is located on your hard disk, and make the following edits.

· Type the word provides before the misspelled word comprejensive in the first sentence.

· Replace the first occurrence of the word for with the word to in the first sentence of the first paragraph.

· Delete the second occurrence of the word has in the sentence beginning A full service agency.

· Replace the Senior Vice President’s name at the end of the letter with your own.

· Select the last sentence in the third paragraph, which begins with We believe, and delete it.

· At the end of the document, add three blank lines after Sincerely to allow room for the signature.

· Change the date to January 1, 2004.

· Make spelling corrections as needed.

The finished document should look similar to the following illustration.
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Exercise 2: Create a subfolder named Putting It All Together in the Lesson02 folder, and then save the edited file from Exercise 1 in the new folder as SkillCheck Lesson 02 Edited.

Exercise 3: Continue to edit the SkillCheck Lesson 02 Edited document.

· Select the entire paragraph that begins With a philosophy and delete it.

· Select the word Sincerely and replace it with Regards.

· You realize that both of the last two edits were a mistake. Undo both of them.

· Close the file without saving your changes.

Exercise 4: If you have a document that is more than a page in length, what is the quickest way to move to the beginning of the document? What is the quickest way to move to the end of the document? Why would this be a useful feature in a lengthy document?

Exercise 5: Does scrolling move your insertion point? Experiment with the scroll bar if you are unsure. How can this be a useful feature?

Lesson 2





Word remembers the folder in which you last saved a document. When you display the Open dialog box or the Save As dialog box, the contents of that folder are displayed so that you can easily find the files for which you are looking.





To open a recently used document from the Open dialog box, on the Places Bar, click the History icon, and double-click the file that you want to open. The Places Bar is located along the left side of the Open dialog box.





You can also open a file by double-clicking the file name in the Open dialog box.





In the following exercises, the Standard and Formatting toolbars are separated. 





When the mouse pointer looks like the I-beam, you can move around and make edits to the text. You can tell when the mouse pointer is in the selection area because the I-beam changes to a right-pointing arrow. The selection area is any location to the left of the left margin of your document.





For more information about key combinations, see Lesson 4, “Formatting Text.”





The key combinations of Ctrl+Page Up or Ctrl+Page Down are not always set to move forward or backward by a page. You can use the Select Browse Object button located between the Previous and Next buttons to select the type of item by which you want to browse, such as page, bookmark, footnote, table, graphic, or other item. This will be discussed in more depth in the next section.





“One screen” is the amount of a document that can be displayed in the document window at one time. This amount will vary depending on your screen area settings and whether the document window is maximized.





The Previous and Next buttons, located below the vertical scroll bar, are not always set to move forward or backward by a page. You can use the Select Browse Object button, located between the Previous and Next buttons, to select the type of item by which you want to browse, such as page, bookmark, footnote, table, graphic, or other item. To browse by page, click the Select Browse Object button, and click the Browse By Page button.





Be cautious when you use Overtype mode. When it is activated, and you insert new text in the middle of a sentence or paragraph, it’s easy to inadvertently lose existing text that you did not intend to remove.





When you drag the mouse pointer past the first word, Word automatically selects entire words instead of one letter at a time.





If your toolbar does not show the Undo and Redo buttons, on the Standard toolbar, click the Toolbar Options button, point to the Add or Remove command, point to Standard on the submenu and click the Undo and Redo buttons. You can also click Undo and Redo on the Edit menu.





Word marks any word not found in its standard dictionary by placing a red wavy line beneath it. After you correct the word, the wavy line is removed. You’ll learn more about the dictionary and spelling check in Lesson 6, “Using Editing and Proofing Tools.”





You can also create folders in any other Microsoft Office 2002 application, in Windows Explorer, or in My Computer.





The My Exercises folder doesn’t appear in the Save In box because it isn’t the last folder in which you saved a document.





A tape backup system stores the content of hard disks on high capacity tapes, which are typically stored in separate locations and are used to recover lost or deleted data.








